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Chapter 1  Introduction

Purpose of Time Creator

TimeCreator is a new program from StockG.com.  TimeCreator will create more time for you by helping
you monitor where your time is going and to use it more efficiently.

TimeCreator is for anyone who:
• Has too much to do
• Is often rushing
• Sometimes misses meetings
• Unprepared for meetings
• Uses a computer
• Someone who wants to reach their goals.
• Doesn’t balance time well
• Doesn’t solve root cause of problems
• Has difficult estimating time
• Has to generate status reports
• Difficulty reaching goals
• Difficulty breaking habits

TimeCreator works by making it easy to track your time.  All functions are linked backed to time tracking :
• To do List
• Phone Book
• Alarms
• Button Bar

Once you start tracking your time you can use it more efficiently.  TimeCreator comes with a number of
tools to help you do this and will give you the following benefits:

• Balance your time
• Reach your goals
• Break habits
• Learn new Positive habits
• Not rush for or be unprepared for meetings
• Easily generate weekly type status reports
• Identify what is interrupting you
• Prevent you from procrastinating
• Prevent you from getting stuck on a task
• Help you to prioritize your tasks
• Identify and solve the root cause of your problems

Features
• Button Bar
• List Maker
• Reminders/Alarms
• Phone directory
• Calendar
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• Command Window

System Requirements
• Personal Computer with a 486/25 or higher processor
• Microsoft Windows 3.1, 3.11, 95, NT 3.51, NT 4.0, 2000, XP
• Mb of memory
• 5 Mb of free disk space
• Modem (optional)
 

Windows Terminology
You should be familiar with the following windows terminology:

Word Definition
Mouse pointer  the arrow to the left which is controlled by moving the mouse
Mouse Pointing device which moves the mouse pointer across screen and supports a left

button and a right button
Button
Click Position the mouse pointer to a button and press the left mouse button
Press Action done to a key on the keyboard or mouse which can be pressed
Cursor Blinking vertical bar indicating where you will be able to type information
Dialog A window which supplies information and allows you to supply it information
Button A graphical depiction of a button on your computer screen
Key An actual key on your keyboard
Drag Place the mousepointer over an item. Press the left-mouse button and hold it down.

The item can be dragged to another position until you release (drop) the item.
Double-click Press the left mouse button quickly two consecutive times while holding the mouse

stationary
Right Mouse The button on the right side of the mouse.
Window
Select
Multi-select
Activating a
Window

You can activate a window by clicking it or by press Alt+Tab
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Chapter 2  Installation

Installing
1) Insert disk into your CD drive
2) System will automatically step you through the installation.

The system will set up the following icon in Program Manager

 

Double click Time Creator to start it and you will be prompted with the following dialog:

Answer “Yes” if you’re running at Home or No if you’re running at work.

Registration
<Registration img goes here>

Press the “Free Trial” button for a 30 day or 240 hour free trial or contact StockG.com at
AlecBerg@StockG.Com 

After pressing the “Free Trial” button the following will be displayed

Click “Ok” to continue
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The first time you use Time Creator you will be asked to enter you name and company name.

Enter your company name or leave blank and press “Accept” and the following will be displayed:

Enter your name and press “Accept” and the Time Creator notice will appear
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Press “Esc” to continue.  The Time Creator Tour and Button Bar will be displayed

The Time Create tour and the Button Bar will be displayed

Time Creator
Tour

Button Bar
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Chapter 3  Tour
Time Creator supports a “Tour” of the system.  The usage of the Tour is described below.

<…………….>
Double Click the text in the brackets to get additional help
Double clicking <Time Creator’s Purpose> will bring up the following dialog:

Double clicking <Button Bar> will bring up the following dialog:
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Back
Will return you to the previous window of the tour

Top
Will move you to the top of the Tour

Next
The Next button will step you sequentially through help

Previous
The Previous button will step you back sequentially through the Hlep

Close

Show at Start up
Click this option off if you don’t want to see the tour

On Top
Click this option to keep the tour on top of other windows
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Chapter 4  Button Bar/Tool Bars 

Purpose
• To give you fast access to the functions you want to perform using the mouse
• You can easily and quickly start programs instead of using clumsy Program Manager
• To give you fast access to a list you’ve made
• To remind you what you are currently working on
• To make it easier to track your time
• To show you what you are currently working on
• To assist you with accurately tracking your time
• To increase your productivity by automating boring and repetitive tasks you perform 
• To enhance the functionality of software you currently use

Overview
The Button Bar is easy to access because it is always on top of other windows and uses minimum  screen
real-estate.  Below is the default Button bar which comes with Time Creator.   

Button Function Description
+ Load Icon to Button Bar Loads a selected icon to the Button Bar

What happens in windows 95, NT 4.0!
Eg Egg Timer Starts the Egg Timer
Li List Maker Starts the List Maker
Ph Phone Book Displays the Phone Book
T Did Today Shows what you’ve done today 
U Undo Last Tracking Undoes the last tracking entry
R Restart Previous Task Restarts tracking the previous task
A Show upcoming Alarms Displays you upcoming alarms
Cl Show Calendar Displays your calendar
F File Manager Starts File Manager
ca Calculator Starts the windows Calculator
Co Control Panel Start Control Panel
Ms Mine Sweeper Starts Minesweeper and tracks that you’re

playing it
So Solitaire Start Solitaire and tracks that you’re playing it
X Exit Exits from Time Creator
St Stop Tracking Stops tracking your time
? Help Displays a list of what each button does

Percent worked
on or Windows
resources left

Current Task

Time elapsed for
task

The Button Bar

If Red indicates
alarms off

Minimize Time
Creator

Show Main
window
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Right Mouse
Pressing the right mouse button while over the buttons on the Button bar will bring up the following Pop-
up menu:

Moving the button bar
To move the button bar position the mouse over any part of the button bar except the buttons, and drag it to
where ever you like (press the left mouse button down and hold it.  Move the Button Bar to where you like
it and remove your finger from the button).

Or activate the Button Bar via the F6 (Next Window) key and press Ctrl+M.  Then using the Arrow keys
move the window and press the Enter key to place it there.

Reordering buttons
To reorder the buttons press the left-mouse button down over the button to move.  Drag the little black
square  to the button you want to move after and release the left mouse button

Minimizing

The Button Bar and Time Creator can be minimized by pressing the  button on the button bar

Removing a button
To remove a button (For example the “Ca” Calculator button) from the Button Bar, press the right-mouse
button while over the “Ca” button to delete and select “Delete Button” from the pop up menu.

You will get a verification message of the following if you try to delete the “Ca” button
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Press “Yes” and the Button Bar will be refreshed without the “Ca” button.

Adding a button/ Button Bar Maintenance
To add a button press the right mouse while over the Button Bar and select “Add a button” 
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Enter the following data:

Field Purpose
Button Char One or two character code which will appear on the button
Tool Tip Data Text to appear in yellow tool tip box
Program to Run Program to run. EXE name.   You can press the Browse button to select it
Current Directory This is the directory where the program must run from
Too Bar Id Select the Tool bar to place the button.  See “Creating a new button bar” on

page 59 for details
Last Used This contains the date and time when the button was last used.  If the button

has been deleted the Last Used date is set to “1/1/1901”.  To restore the button
delete this date.  See “Aging” on page  61 for more details

New Button Allows you to add a new button
Find Button Assists in finding an existing button
Delete Button Deletes a button
Close Button Closes the button maintenance window

Do Function List
The Do Function field allows you to specify a specific function which is preprogrammed into the button

Do Function Purpose
(None) No function
Start Main Screen This function will start and display the Main screen
Did Today Shows you a list of what you did today
Undo Last Entry This function will remove the last tracking entry you made by

mistake
Restart Previous Task Restarts the time tracking for the previous task you were

working on
Start List Maker Starts and displays the List Maker program
Start Phone Book Starts and displays the phone book
Display Upcoming Alarms Displays a list of you alarms sorted in date time order
Display Help Displays tool bar help
Exit Exits Time Creator
Open List Maker with List
specified in Program to Run

Opens the text specified in the Program to Run field and
opens the list for viewing

Kill Program Manager This function is only available under windows 3.1 or 3.11.  It
allows you to shut down program manager and use Time
creator instead.  This could be useful to save resources.

Show Calendar Displays your Calendar
Start Egg Timer Displays the egg timer
Update the comment Allows you to enter a comment for the current task being

tracked
Set an Alarm for current task This function allows you to set an alarm for the current task

being tracked
Copy a Highlighted item in
program manager to button bar

This function is only available under widows 3.1, 3.11 or
3.51.  It allows you to easily add programs to you Button Bar.
You select the program via program Manager and press this
button

Button Bar Maintenance Starts the Button Bar Maintenance software which allows you
to Add, change, delete, restore a button
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Stop Tracking This function stops tracking you current task and changes the
current task to Unaccounted.

First-Prev-Next-Last

This control is used to position to the First Button, Previous button, Next Button and the last button
respectively.  Once you change the data it is modified.

Load Program Manager Icon to Button Bar
1)  Go to Program Manger

2)  Select a program to add to the button bar.  In the above example “Command Prompt” is selected.
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3)  Press the  button, and the button will be added

“CM” Button is added.  It will blink to show you where it was added to.  Click the button to bring up the
Command Prompt

While on a Microsoft Word document you can press the “+” button to add  the document to the button bar. 

Interruptions
The Button bar can be used to track interruptions.   If you double click the task area the system will start
tracking an interruption.  You can press the          button (it’s in the upper left corner) to start an
interruption also.

Interruption is being tracked. 

~

Double click
here
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Chapter 5  Command Window

Purpose
The Command Window give you the ability to execute commands, perform functions without using the
mouse, just the keyboard.

Starting
To start the Command Window do one of the following:
• Press Ctrl+Alt+J
• From the "Main Window" select “Show Command Input Line” from the “Tool Bars” menu.

The "Command Window" is always on top. You can:

Enter Function
Two character "Button Bar"
text

Executes the "Button’s function.

File Name Executes the associated program with the file
<button char> <n> Will execute the specified button <n> times in a row
<button char>! Will change the order of execution of buttons with duplicate characters
<button char>? Will show a list of duplicate functions to be executed if you press the

button.  If there is only one function with the <button char> it will be
executed.

Esc Closes the "Command Window”
Double-Click Closes the "Command Window”

Type in you
command here

Drag here to
move the
window

Drag here to
resize the
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Examples
Enter Description Result

Eg Egg Timer is displayed

Ph Phone Book window displayed

pe
ca Windows Calculator is displayed

co Control Panel is displayed

pbrush Paint brush program is displayed
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Chapter 6  List Maker

Purpose
• To create lists
• To Do Lists
• Check Lists
• List of Goals
• List of Ideas
• List of your bosses or spouses unwritten rules
• List of important numbers to remember like combination locks, credit card numbers, passwords, etc.
• Shopping List

Overview
The List Maker allows you to create lists.  You are basically creating a multi-level list or an outline.   The
“Top”  is you main list which can have any number of sub-lists.  Each list can be set up to be accessed by
the click of a button on the Button bar.   Each list supports a series of options which are available in
“Advanced” mode.  Each list is “sticky” whereever you left off on the list, will be there the next time you
bring up the list.   There is also the capability to Track your time and set alarms from items on the list.

Starting
To start the List Maker do one of the following:
• Click the “Li” button on the Button bar
• Press Ctrl+Alt+J and type “Li” and press Enter. 

• Bring up the Main window, and press the List Maker button 

Closing
You can close the List Maker by pressing the Esc key,  double clicking the Control Box, Pressing Alt+F4
or selecting “Close” from the File Menu
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Window
Below is the List Maker window and various parts of the window

Functions

Positioning to a list
Press the “Top” button to go to the Top Level list

Double click an item to go to the list for the item.  If there isn’t a list a new one will be created

Add an item to current List
Position to “Text to Add” field via Tab key or Alt+X.  Type in the text and press the “Enter” key or click
the “Add” button.

If the item you’re adding is two words or less the following message will appear:

Name of List Enter Text here
to add to list and
press enter

Number of items
in list

Comment field

@ here indicates
alarm. Double-
click to view

+ sign indicates
item has a sub-
list

Field Help
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 This is misleading! Me thinks me can press alt+f
here

Create a new list
Double click an item in a list
or Click the “Downlvl” (Down Level) button or press Ctrl+L

Adding a List to the button bar
You can use list maker to create a list and press the “Add Button” button. (Note: you must have “Advanced
Options” selected.)

Move down a level
Each list can have sub-lists.  To move down a level double-click an item or click the “DownLvl” button or
press Ctrl+L.

Items with sub-items are prefaced with a “+” sign.

Move up a level
To move up a level click the “Up Level” button or Ctrl+U  

Track your time
To track you time, select the item to track and do one of the following:
• Press Ctrl+T  (“T” for Track)
• From the “Tracking” menu select the “Track” sub-menu option
• Click the Track button  (available only when Advanced selected)

Set an Alarm/Reminder
The Time Creator system supports Automatic alarms.  If the text of your item contains certain key phrases
or words like “Meeting”, “Birthday”, “Anniversary”, the system will present you with the “Set Alarm”
Dialog where you can cancel, modify or enter the alarm.
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Type the above task
and press enter key.
The following Alarm
screen will appear:

Data is automatically
entered
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The Date is already set.  In addition you will get an early warning 10 days before the 23rd  and this alarm
will repeat every 365 days or each year.  This task will also appear on your calendar.  Click the “Ok”
button to accept or cancel button to not set the alarm.  The List Maker will display as follows:

To set an alarm or reminder that isn’t automatic select the item from a list and press Ctrl+A (“A” for
Alarm) 

Search All 
To search for a string in all of you lists and comment field:
Enter data to search and select “Edit”, “Search All” or press Ctrl+E.
Click an item and the Parent will be displayed.

Delete an item from a List
Select the item or items to delete and click the delete button

or “Delete” key.  See “Restoring a deleted item” on page 26, if you delete something by accident.

Find an item
To search for an item in the list, enter data in the text box and click the “Find Next” button or press Alt+F.

Modify the list
To modify an item in the list, select the item and click the “Modify” button  or press Alt+Y.

Indicates that the
alarm is set.
Double-click to
display the alarm
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Modifying the order of the list
To modify the lists order: 
1)  Highlight the item to move
2)  Press Ctrl+Up arrow to move the item up or Ctrl+Down arrow to move the item down in the list
3)  Click the “Save” button to save the order

Go to the Top List
To go to the top list press the “Top” button

Restoring a deleted item
Items in the list maker aren’t actually deleted, they are marked as deleted and can be restored.  To restore a
deleted item you first must show the deleted items.  Select either “Show Deleted” or “Show Deleted Only”
from the Options Menu.  Show Deleted will show all deleted items with a “[D]” at the end.  The show only
deleted will show only the items which have been deleted.

File Menu

Print Selected Items
This function will print the selected items and all of it’s sub-items
1)  Select items to print
2)  From the file menu select “Print Selected Items”

Print Daily Planner Size
This option will print you current list on “Daily Planner Size” Paper

Print Selection and Comment
This option will print the Selected items and their comments.  The items heading will be in a Bold font.

Print Set Up
This function allows you to change various printer settings



Time Creator User Guide 2.0

-27-

Function Purpose
Bold Allows you to print the list in a bold font
FontSize Allows you to change the default font size
Skip Lines Allows you to skip the entered number of lines between each print line
Print All Children Will print all children of item being printed
Print Memo Will print the Comment 
Print Numbers Will number all printed items
Return Closes the dialog

Close
This menu selection closes the List Maker window

Edit Menu

Find Next
Enter text in the “Text to Add” field and select this item from the menu or press Ctrl+F to search the
current list for the entered data.  The list will be positioned to the item.

Add to End of List
This will add an item to the end of the current list.  The Add button or the Enter key performs the same
function

Modify Current Selection
Select an item from the list and the select this function.  

Select this task

Click Modify
button or press
Alt+Y
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A dialog will appear which will allow you to modify the selected data.

Change the text.

And press “Accept”.  The List Maker item will be updated

Delete
Select this option to delete the currently selected items.   Any items you delete are only logically deleted.
See “Delete an item from a List” for details on page 25.

Task has been
modified
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Restore Deleted
This function allows you to restore a deleted item.  
1)  Make sure “Show Deleted” or “Show Deleted Only” option is set
2)  Select one or many deleted items 
3)  Select “Restore Deleted” and the items will no longer be deleted

View Menu

Top
This function will take you to the “Top” list

Up Level
This function will move you up one level list (Ctrl+U)

Down Level
This function will move you down one level (Ctrl+L)

Show History
This function will show the various Lists you have viewed (Ctrl+Q)

Double click an item to go to the list

Tracking Menu

Track
Select “Track” from the “Tracking” menu or Press Ctrl+T (“T” for Track) while an item is selected
Example:  I want to track that I’m watching TV
1)  Bring up the List Maker  (Press the “Li” button on the button bar. 
2)  

 
 
 
 



Time Creator User Guide 2.0

-30-

Select “Watch TV Today” from the List

Press Ctrl+T or select Track from the Tracking Menu and the following will appear in the Button Bar:

Missed Task
If while you were watching TV you decided to go to the bathroom but forgot to enter it then you can use
the “Missed Task” function:  Go to the list with the Task bathroom.
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Press Ctrl+M (Missed Task)  or select Missed Task from the Tracking Menu. The following dialog will be
displayed

Enter the number of minutes you were in the bathroom for and press Accept.  You can also set it by Time
or some time Yesterday and the time for the previous task will be adjusted.

The Up and Down Arrow keys can be used to modify the time field
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Replace Task
This function can be used if you accidentally selected the wrong task.  Select the correct task , (Play
Solitaire) and select Replace Task from the menu or press Ctrl+R (R for Replace)

The Button Bar will change as follows:

Set Alarm
Select the task you want to set the alarm for and select “Set Alarm” from the “Tracking” menu or press
Ctrl+A (A for Alarm)
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You will be presented with the following dialog:
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Set the following options

and press the OK button.  See page 36” Set an Alarm/Reminder” for details.

The List Maker window will appear as follows:

The Alarm is indicated by the “@”.   You can double click this character to see the details of the alarm.
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Options Menu
The following items are standard options which can be set for the List Maker

Option Purpose
Show Deleted This option shows deleted items with a “[D]” at the end of the text
Show Deleted Only This option shows only items which have been deleted from the list
Show Field Help As the mouse pointer moves over each field helpful information about the

purpose of the field will be displayed on the bottom of the window
Increase font This allows you to increase the font size of the List
Decrease Font This allows you to decrease the font size of the List
Drag mode This changes the functionality of multi-select to drag and is used to assign

a task to be tracked via a button

Tools Menu
The following are some tools which can be used via the list maker
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Tool Purpose
Spell Check This function will perform a spell check on the data in the “Text to Add”

and “Comment” fields.  You must have Microsoft Word for the function
to work.

Randomly Select an Item This function can help you make decisions or to work on something you
keep procrastinating.  You can set up a list of Procrastinated Tasks, set an
alarm to do them every Monday at 2 pm and then randomly select one to
do.

Add Button to Button Bar This function will add a button to the Button bar which will immediately
bring up the List.

Set Date Time in Text This function will insert the date and time into the text.

Accelerator Keys
include table here!



Time Creator User Guide 2.0

-37-

Chapter 7  Reminders/Alarms

Purpose
• To prevent you from forgetting tasks
• To prevent you from being late for meetings or appointments
• To prevent you from rushing
• To assist with tracking of your time
• To prevent procrastination
• To Balance time by setting an hourly alarm which can force you to move on and not get stuck on a

task

Features
• Supports Early Warning, Travel, Prep and End Task Alarms
• Can play a sound file as an alarm
• Can perform a Sendkey routine when an alarm is reached

Egg Timer
The system supports a “Egg Timer”.  This egg timer will keep the proper time even if you shut down and
start up the Time Creator system.  If the egg timer expired while Time Creator was shut down, then the
system will tell you this.

To start the Egg timer do one of the following:
• Press the “Eg” button on the button bar

 

• On the Main window press the Egg Timer Icon 

The Egg Timer dialog will be displayed:

When you press the “Start” button the dialog will be displayed as an icon with the time being decremented. 

Key pad entry
using the mouse.
“d” will delete

Checked to
sound alarm
when complete

Button to start
the egg timer

Enter the
number of
minutes to set
the alarm
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00:23:34  

Setting an Alarm
Alarms/Reminders can be set via the following functions:
• List Maker
• Did Today Dialog
• Button Bar - sets alarm for current task
• Contact Manager can set a Smart Alarm 

Set Alarm Window

Function Notes
Early Warning This function is useful to give you ample time before an event to do something.  It is

useful to set birthday alarms for an early warning of 10 days before the actual alarm so
you have time to get a gift and a card

Travel This allows you to be on time for your meetings by assigning an amount of time to
travel to an appointment.

Prep This allows you to be prepared for meetings by specifying how much time you need to
prepare.

Repeat Every Allows you to set up a repetitive alarm.   
Daily Alarm = 1 day
Weekly Alarm = 7 days
Monthly Alarm = 30 days
Yearly Alarm = 365 days
You can set the repetitive alarm by the minute or hour

Date/Time of the
Alarm

Early Warning
before the alarm
sounds

Alarm to remind
you to travel to
your meeting

Alarm to remind
you to Prepare
for your task

How often to
repeat the alarm

To get a
reminder that the
task is complete
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End Task This alarm will remind you to finish the task you are working on and give you the
ability to better balance your time

Except
Weekends

This option allows you to set daily alarms which don’t notify you on the weekends

Advanced Displays Advanced Alarm Options
Show on
Calendar

The text of the alarm will be displayed on the calendar if this item is checked.  If you
enter Prep, Travel or Early Warning time this field is automatically checked for you.

Comment Will display a comment on the alarm

Viewing Alarms
To view your alarms do one of the following:
• Click the “A” button on the Button Bar
• Select “Show Upcoming Alarms” from the “Alarms” menu on the Main Window

Deleting an Alarm
To delete an alarm, select the alarm to delete and click the Delete button on the window.

Turning off alarm sounds
To turn off Alarm sounds press the maximize button on the Button Bar

and the Main window will be displayed
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Click the “Sound On” check box off 

Turning off Alarms
There are 3 ways to turn off alarms
1)  Double click the Date/Time on the Button Bar
2)  Click the “Alarm Off” on the Main Window
3)  Press the “Alarm Off” button when accepting alarms

Note:  any alarm with an early warning, prep or travel will always be displayed even if alarms are turned
off

Accepting Alarms

The Time Creator system will check for expired alarms every 30 seconds.  If  any alarm has expired the
following dialog will be displayed.   Alarms won’t be displayed  if you are typing.  The system waits for no
typing for 5 seconds before an alarm is displayed.

Button Purpose
Delay 1 Hr Delays the current alarm for 1 hour
Delay 5 min Delays the current alarm for 5 minutes
Delay… Brings up the Delay dialog so you can specify how long to delay the alarm
Accept Starts tracking your time 
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Remove Clears the alarm
Modify Allows you to modify the alarm
Alarm Off Shuts off your alarms
Chg Loc Changes the location of the alarm from Home to Work or from Work to Home

Delay Dialog

Above window changed!
You can enter how long to delay the alarm.

Alarm specific Buttons

View Upcoming
Alarms

Set alarm for
current task
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View Upcoming Alarms

Set an alarm for the Active task

Click the “Al” button to set an alarm for the current task.  If your currently playing Solitaire and want to
play it at 8 pm, 

Change the time to 8pm and press enter.
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Smart Alarms

Short Phone Calls
If a phone call is less than 3 minutes (Note: the task must have the word “phone” or “call” in it) the system
will ask you if you want to set an alarm for the task

If you press yes you’ll be presented with the Set Alarm Dialog:
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Chapter 8  Contact Manager/Phone Book

Features
• Keep a list of your contacts
• If you have a modem it can dial the phone for you
• Can store multiple address and phone number for each person
• Can be quickly initiated off of the button bar
• Can track the time of your phone calls
• Set an alarm to remind you to follow up on a call

Window

Add a contact 
Press the “New” Button and the following dialog will be displayed:

Phone List
sorted by name

Phone numbers
for selected
Contact

Address
Selection

Office Address
Button Search

Modify Drop
Location

Deletion Drop
Location



Time Creator User Guide 2.0

-46-

Field Description
Name Enter your contacts name here.  If you want to see

you contacts in last-name, first-name order then
enter the name in that order “Doe, John”.  If you
want to see your list in first-name order, then enter
your contacts as  “John Doe”

Phone The phone number goes here
Type This is the type of phone number “Home”, “Work”,

“Office”, “Business”, 
Area Code The 3 digit area-code
Exch This is the phone exchange which is the first 3

digits of the 7 digit phone number
Number This is the last 4 digits of the 7 digit phone number
Extension This is a phone extension 
Type of Address This is the type of address entered such as “Home”,

“Work”, “Summer”, “E-mail”, “Directions”,
“Family Info”

Address Enter the address or data here

Press the “Ok” button to save or the “Cancel” button to exit.
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Search for contact
Enter the character of the contact you want to search for
Standard window wildcard characters are supported:
“*”- any character
“?” - 1 character place holder
Examples
*Doe - will position to the first name starting with any characters ending with “Doe”
*Doe* - will positions to the first name starting with any characters, the characters “Doe” and ending with
any characters.

Dial a phone number
To dial a phone number, position to the contact, select the phone number and click the “Dial” button
If  you track a task which starts with the word “Call” and has a @ with a number following it, the system
will try to dial the phone number for you.  

Tracking time of phone calls
The system will track the time of your phone calls when you press the dial button.   

Add additional Phone number to a contact
Click the “Add Number” button and enter the Phone information

Add Additional Address to a contact
This function can also be used to keep directions, Information about a person.  Click the “Add Address”
button and enter the address.

Filtering
You can show “All” numbers, “Active” numbers or “Inactive” numbers.   To change the setting of a phone
number, select “Activate/Deactivate” to change an “Active” number to “Inactive” and vice versa.
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Options
The following options can be set:

Field Value
Area Code Enter your area code
Modem Prefix This allows you to set a Modem prefix use “ATDT”

for tone dialing and “ATDP” for pulse dialing.
Local Call prefix Enter the prefix you must enter to dial a local phone

number
Long Distance Prefix Enter the prefix you enter to make a long distance

call
Modem Port Enter the port to which your modem is connected.

Usually a value from 1 - 4.

Modifying data
• To modify the Name or type of phone number, drag the field to the pencil eraser.

The “Modify” dialog will be displayed
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• To modify an address click the “Fix Address” button
• To modify a phone number you  must delete the phone number and then add it again.

Deleting data

To delete a name from the phone book, drag the name to the trash can.

The following type of message will be displayed:

Click “Yes” to delete the item.

Add comment to phone call
Whenever the last task you were tracking has the word , “meeting”, “appointment”, “call” or “phone” the
system will ask you if you want to update the comment

 \

You can view the comments on the “Did Today” window.  See page 49 for details.



Time Creator User Guide 2.0

-50-

Chapter 9  Time Tracking

Purpose
To help you keep track of how you spend your time so you can:
• Increase your productivity by identifying and eliminating time wasters
• Easily generate Time Sheets and Status Reports
• Prevent you from spending too much time on one task
• Help you to balance your time
• Help you to work less by improving your task estimates

Features
• Easy to track your time
• Easy to Adjust tracking mistakes
• Tracking can be semi-automatically performed via accepting alarms
• Tracking can be performed from many places
• Easy to track interruptions
• Easy to track phone calls
• The current task you are working on is displayed in the "Button Bar" so you know if you are

accurately tracking your time

Tracking Your Time

List Maker
To track your time via the "List Maker" you must position to the task you want to track and press Ctrl+T.

Button Bar
• You can track an interruption by double clicking the current task field
• Two buttons are already set up to allow time tracking.  The “Ms” and the “So” buttons.  To add a

button which tracks your time, do the following:
1)  Go to the List Maker
2)  Turn on “Drag” Mode
Drag the text for a task and drop it onto a button.

Alarms
Click the “Accept” button when an alarm is displayed and that task will be tracked

Contact Manager
Press the “Dial” button to dial a number and the task will be tracked

Did Today
To track from the “Did Today” window, double click an item you want to track you time with or select the
item and click the “Select” button.
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Viewing your tracking data

Did Today

Click the “T” button on the "Button Bar" to view the “Did Today” window.  It will show you what you did
today.
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Status Reports

Correcting/Adjust your time tracking

Replacing the current task
You will typically use the “Replace” function when you’re tracking an interruption and you want to enter
the actual task that you are doing:

• From "List Maker" Select the task you want to track and press Ctrl+R or select “Replace Task” from
the “Tracking” menu

• From “Did Today” Drag a task from one place to the place you want to replace it with

Undoing the current tracking entry
• From the "Button Bar" click the “U” button
• From the "Command Window" enter the “U” command
• From the "Main Window" select “Undo Last Entry” from the “Tracking” menu

Entering a “Missed Task”
• From the "List Maker" select the item you missed tracking and press Ctrl+M or select “Missed Task”

from the “Tracking” menu.
• From “Did Today” select the item you missed tracking and click the “Missed” button or press Alt+M.
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You will then be presented with the “Missed Task” dialog:

Combining two entries into one entry
From the "Did Today" window, you must have the “Advanced” button checked.  Select the first task you
want to combine with the second task.

Click the “Combine” button and the ? dialog will be displayed:
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Click “Ok” and the time for the two tasks will be combined into one task.

Adjusting time entries
To Adjust the time entries on "Did Today" select an item and click the “Adjust” button.   The “Adjust”
dialog will be displayed.  Adjust the times and press Ok.

Splitting one task into two tasks
On the "Did Today" window select a task and press the “Split” button.  The task will be split into two
separate tasks with the same description.
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Chapter 10  Resource Monitoring

Purpose
This was originally a function used by Windows 3.1 to monitor the free resources and disk space.
Running low on theses resources could adversely affect the Windows system.

 If the resources on Windows 3.1 goes below 10 percent the system beeps and displays a warning.

If the available disk space goes below 5 Mb. the system displays a warning message.   This value can be
changed via the “Additional Options” window.
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Chapter 11  Options
You can set various options in Time Creator.  The system options allow you to specify which parts of Time
Creator you will use.  Select “System Options from the “Options” submenu from the “Tools” menu.

Select “Additional Options from the “Options” submenu from the “Tools” menu. 
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Option Description
Home Phone Options See “Options” on page  47 for details
Work Phone Options See “Options” on page 47 for details
Lost Time Warning This option allows you to get a warning beep every time the system is busy for

more than the specified number of seconds
Lost Time Alarm complete this section  out!
Warning when disk
space falls below

Causes the system to warn you when you are low on disk space below the
specified value

Suppress Copyright
Screen

Check this option to suppress the display of the copyright screen at start up

Kill Program
Manager at Start up

This option allows you to shut down the “Program Manager” when Time Creator
starts up.  This option is only available to Windows 3.1 users.

Daily Planner Font
Name
Daily Planner Font
Size
Line Length
Page Len
Left Margin
Tool Help Displays or hides the tool help
Show Calendar at
start up

The system will display your calendar for you the first time for the day you start
Time Creator.

Display Seconds Changes certain time displays from minutes to seconds
Center Messages Click off to have Time Creator messages to appear next to wherever the mouse

pointer is located to save you time in click the buttons.
Egg Timer Sound This is the default sound if the user doesn’t have a sound card
Important Alarm
Sound

Important alarms can have their own sound if there is no sound card or you
haven’t set up the alarm to play a sound

Age out unused
buttons in x days

This allows you to set a number of days for a button to be removed from your
button bar if you’re not using it.  These buttons can be restored by the “Restoring
Aged Buttons” function. See page 61 for details.  The system defaults to 32,000
days which is 87 years.

Button Font Size This allows you to change the font on the buttons
Button Multiplier This allows you to enlarge or reduce the size of the buttons
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Chapter 12  Advanced Functions
The Time Creator system supports some advanced functions.  To see and use the advanced functions you
must click on the “Advanced” options.

Button Bar Maintenance

Window

Field Purpose
Send Key Data Contains the Id number of the Send Key data to be used.  See “Send Key Data” on

page 57.
Maintain Allows you to create a send key routine to associate with a button
Location Supports three locations, “Home”, “Work” or “Both”
Window Caption Used for the system to detect which window to send data to
Window Class A internal identifier of the window
Reminder Displays the entered text when you click the button on the button bar

Send Key Data
The purpose of  "Send Key Data" is to automate repetitive tasks by allowing you to perform them with the
click of a button on the "Button Bar”.   What the "Send Key Data" does is send pre-entered key strokes to a
window to perform a function.   To set up a send key routine is hard, but once you get the hang of it you’ll
be saving so much time, you’ll never understand how you worked without them.

Steps to creating a "Send Key Data" routine.
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1)  Detect a function you perform over and over
2)  Write down the key strokes and windows you type into
3)  Convert the list of key strokes into a "Send Key Data" routine.
4)  Test the routine
5)  If the routine isn’t working try adding delays or get smaller pieces of the routine to work

Send Key Command Function
A - Z, 0 - 9 This data will be sent to the Active Window
+, ^, %, ~ and ( ) These keys have special meaning.  To specify one of these characters, enclose it in

braces.  For example to send the “+” key specify {+}
{BACKSPACE} or
{BS} or {BKSP}

Backspace

{BREAK} Break
{CAPSLOCK} Caps Lock
{CLEAR} Clear
{DELETE} or
{DEL}

Del

{DOWN} Down Arrow
{END} End key
{ENTER} or ~ Enter
{ESCAPE} or
{ESC}

Esc

{HELP} Help
{HOME} Home
{INSERT} Ins
{LEFT} Left Arrow
{NUMLOCK} Num Lock
{PGDN} Page Down
{PGUP} Page Up
{PRTSC} Print Screen
{RIGHT} Right Arrow
{SCROLLLOCK} Scroll Lock
{TAB} Tab
{UP} Up Arrow
{F1} - {F16} F1 - F16
+ Shift key
^ Control
% Alt
+(EC) Hold down shift and press E and then C. Use parenthesis with “+, ^, %” to hold

down the key while the others are pressed
{LEFT 20} This presses the Left key 20 times.   You can enter this repetition factor with any

keys.
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Estimate gauge 
The system will notify you on how much work you have done based on your estimate.  A yellow gauge
will appear behind the task which will indicate the time you’ve spent on the task vs. your estimate.  To set
an estimate for a task see “Setting List Options” on page 63.  You will also receive a warning if your
estimate has been exceeded and you will be able to enter a comment.

Creating a new button bar
Press the Right Mouse button while over the "Button Bar"  and the following pop up menu will appear:

Select “Create/Modify Tool Bar” and the “Define Tool Bar” dialog will be displayed:



Time Creator User Guide 2.0

-61-

Closing a Tool bar
You can close a tool bar by activating it and pressing the “Esc” key

Saving a button/Loading a button

Sendkeys

Entering Userid’s and passwords

Button Bar Maintenance Advanced options
-------Advanced-------- This is a button that will give you access to some advanced features
Send Key Data A number representing the “Send keys” to be executed when the button is

pressed
Maintain Button Will display the Send keys form so you can modify the send key routine
Last Used This is the date that the button was last used.  This date is also used for aging

of the buttons
Window Caption Used by the Sendkeys to determine which window will get the data
Window Class Used by the Sendkeys to determine which window will get the data
Reminder This will display a reminder for you whenever the button is pressed

Do Function Table
The Do Function field allows you to execute a predefined function which the Button will perform:

Kill Program Manager Adv
List aged buttons Adv
Save clipboard to 'CB' button Adv
Send Description to last active
window

Adv
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Send keys from a file Adv
Toggle Between Home and Work Adv
Unload all forms to save
resources

Adv

Button Bar Maintenance fields
Tool Bar Id This is a list of the tool bars on the system.  Select the tool bar which the

button will appear on.  To add a tool bar see “Creating a new button bar” on
page 59

Do Function This allows the button to execute a special function.  See table below for
details.  See “Do Function Table” on page 60.

Location Both, Home or Work.  This allows you to customize you system for home or
for work or both

Start Tool Bar This allows the button to start up a tool bar
Task To Track This displays the task that will be tracked when the button is pressed

Aging
The Time Creator supports a concept called aging.  This function allows you to automatically have buttons
which you haven’t recently used be removed from the button bar.   On the options window you can set the
number of days of non-usage to remove the buttons.  Note: that the buttons can be restored via the

Restoring Aged Buttons
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Moving buttons between Button bars

Importing/Exporting Buttons
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List Maker

Advanced List Maker Window

Setting List Options
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Selecting multiple items
Some functions in the List Maker,  can apply to multiple selected items.  To select multiple items, press the
left mouse button and drag the mousepointer over the items to select.  You can also hold the Ctrl key and
click each item you want to select. 
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